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1. Introduction 

Overview 
Moxa Universal PCI (UPCI) multiport serial boards can be installed in PCI or PCI-X slots, and support both 
3.3V and 5V PCI/PCI-X. With a UPCI board, you can connect data acquisition equipment and other serial 
devices to your PC over RS-232, RS-422, or RS-485. Each board has on-chip hardware and software flow 
control, a built-in 128-byte Tx/Rx FIFO, and well-designed device drivers that have been fine-tuned. This 
allows Moxa UPCI boards to support data transmission speeds of up to 921.6 Kbps. 

The following UPCI multiport serial boards are available from Moxa: 

8 Ports 
CP-118U: 8 ports, RS-232/422/485 
CP-118U-T: 8 ports, RS-232/422/485, wide temperature 
CP-118U-I: 8 ports, RS-232/422/485, 2KV optical isolation 
CP-118U-I-T: 8 ports, RS-232/422/485, 2KV optical isolation, wide temperature 
CP-138U: 8 ports, RS-422/485 
CP-138-T: 8 ports, RS-422/485, wide temperature 
CP-138-I: 8 ports, RS-422/485, 2KV optical isolation 
CP-138U-T-I: 8 ports, RS-422/485, 2KV optical isolation, wide temperature 
CP-168U: 8 ports, RS-232 
CP-168U-T: 8 ports, RS-232, wide temperature 

4 Ports 
CP-114UL: 4 ports, RS-232/422/485, low profile 
CP-114UL-T: 4 ports, RS-232/422/485, low profile, wide temperature 
CP-114UL-I: 4 ports, RS-232/422/485, low profile, 2KV optical isolation 
CP-114UL-I-T: 4 ports, RS-232/422/485, low profile, , 2KV optical isolation, wide temperature 
CP-134U: 4 ports, RS-422/485 
CP-134U-T: 4 ports, RS-422/485, wide temperature 
CP-134U-I: 4 ports, RS-422/485, 2KV optical isolation 
CP-134U-I-T: 4 ports, RS-422/485, 2KV optical isolation, wide temperature 
CP-104UL: 4 ports, RS-232, low profile 
CP-104UL-T: 4 ports, RS-232, low profile, wide temperature 
CP-104JU: 4 ports, RS-232, 8-pin RJ45 connector on-board 
CP-104JU-T: 4 ports, RS-232, 8-pin RJ45 connector on-board, wide temperature 
POS-104UL: 4 ports, RS-232, low profile, serial port powered 
POS-104UL-T: 4 ports, RS-232, low profile, serial port powered, wide temperature 

2 Ports 
CP-112UL: 2 ports, RS-232/422/485, low profile 
CP-112UL-T: 2 ports, RS-232/422/485, low profile, wide temperature 
CP-112UL-I: 2 ports, RS-232/422/485, low profile, 2KV optical isolation 
CP-112UL-I-T: 2 ports, RS-232/422/485, low profile, 2KV optical isolation 
CP-132UL: 2 ports, RS-422/485, low profile 
CP-132UL-T: 2 ports, RS-422/485, low profile, wide temperature 
CP-132UL-I: 2 ports, RS-422/485, low profile, 2KV optical isolation 
CP-132UL-I-T: 2 ports, RS-422/485, low profile, 2KV optical isolation, wide temperature 
CP-102UL: 2 ports, RS-232, low profile 
CP-102UL-T: 2 ports, RS-232, low profile, wide temperature 
CP-102U: 2 ports, RS-232 
CP-102U-T: 2 ports, RS-232, wide temperature 
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Smartio—The Smart Multiport Async Solution 

The Smartio Series of multiport serial boards includes the CP-168U, CP-104UL, CP-104JU, POS-104UL, CP-
102UL, and CP-102U. These boards provide RS-232 serial ports for connecting terminals, modems, printers, 
scanners, cash registers, bar code readers, keypads, numeric displays, electrical scales, data acquisition 
equipment, and many other serial devices to a PC. These boards are a reliable, high-performance solution 
for multiport serial communication. 

Industio—The Industrial Multiport Async Solution 

The Industio Series of multiport serial boards includes the CP-118U-I, CP-118U, CP-138U-I, CP-138U, CP-
114UL, CP134U, CP-134U-I, CP-132UL, and CP-132UL-I. These boards are designed for industrial use, with 
serial ports that can be configured independently for RS-232, RS-422, or RS-485 operation. Industio boards 
provide a reliable communication link over distances of up to 4000 ft and support point-to-point full-duplex 
or multi-drop half-duplex. With RS-485 operation, a single port can connect to 32 devices in a multi-drop 
environment. 

ADDCTM (Automatic Data Direction Control) for RS-485 

ADDC™ (Automatic Data Direction Control) makes it easier to manage 2-wire RS-485 half-duplex 
connections, eliminating the need for software interference. This means that it is not necessary to write 
extra code for Windows applications to control the half-duplex protocol. ADDC intelligence is built into 
Industio boards.  

Serial-over-fiber Board 

The CP-102UF is a serial-over-fiber board designed for industrial automation applications that require a long 
distance, multi-point, PC-based data acquisition solution. The single-mode model (CP-102UF-S) can 
transmit up to 40 km, and the multi-mode model (CP-102UF-M) can transmit up to 5 km. For many 
industrial applications, an even bigger benefit is that optical fiber isolates the data from dangerous increases 
in ground potential, ground loops, and electrical EMI/RFI electromagnetic radiation. 

Built-in Termination Resistors for RS-422 and RS-485 

Industio boards have termination resistors built-in, eliminating the headaches involved in determining the 
proper impedance for the resistors. For additional information, refer to Chapter 2. 

ESD and Isolation Protection 

Certain models include TVSS (Transient Voltage Surge Suppressor) technology to help prevent damage due 
to lightning or high potential voltage. Optical isolation (2000V) and embedded protection (max. ESD of 16 
KV, max. EFT of 2 KV) are also available with certain models. These features help provide protection in 
critical or harsh factory-type environments. 

PCI Solution 

UPCI boards comply with PCI Spec. 2.1 and do not require switches or jumpers. IRQ and I/O address is 
automatically assigned by the PCI BIOS. This means that the board must be physically installed in the 
computer first before the driver software is installed.  

Universal PCI 

For maximum compatibility with the PCI local bus specification, UPCI boards support both 3.3V and 5V PCI 
connector types. The 32/64-bit PCI local bus specification specifies both a 3.3V/5V and 32/64-bit slot. 

Operating System Support 

Moxa UPCI boards are compatible with most major industrial platforms, including Windows, DOS, and Linux. 
Drivers are provided for smoother installation, configuration, and performance. This manual provides 
separate sections for the different operating systems that are supported. 

Moxa Serial Communication Tools 

For application development, Moxa provides a serial communication library for Windows called PComm. This 
library can help you develop your own applications in Visual Basic, Visual C++, Borland Delphi, and more. 
Utilities are included for debugging, monitoring communication status, terminal emulation, and file transfer. 



 

 

Universal PCI Board User Manual 7 

Applications 
UPCI boards are suitable for many industrial applications, including the following: 

• Multipoint data acquisition 

• Factory automation 

• Critical industrial control 

• Remote serial device control 

• Internet/intranet connections 

• Remote access applications 

• Multi-user applications 

• Industrial automation 

• Office automation 

• Telecommunications 

• PC-based vending machines or kiosk systems 

• POS (Point-of-Sale) systems 

Package Checklist 
UPCI boards are shipped with the following items: 

• 1 Moxa UPCI multiport serial board 

• Low profile bracket (low profile models only) 

• Document & software CD 

• Quick installation guide (printed) 

• Warranty card 

 NOTE 
 Notify your sales representative if any of the above items is missing or damaged. For information on 

optional accessories for each model, refer to Chapter 5. 
 

Product Features 
Moxa UPCI boards enjoy the following features: 

• Over 700 Kbps data throughput for top performance 

• Serial communication speed up to 921.6 Kbps 

• 128-byte FIFO and on-chip hardware and software flow control 

• Universal PCI supporting 3.3V PCI, 5V PCI and PCI-X 

• Driver support for Windows, Windows CE, Windows XP Embedded, DOS, Linux, FreeBSD, QNX SCO 
OpenServer, UnixWare7 

• On-board 15 KV ESD protection 

• Low profile for compact-sized PCs (on “L” models only) 

• -40 to 85°C wide temperature (on “T” models only) 
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Product Specifications 

 NOTE 
 The latest specifications for Moxa’s products can be found at https://www.moxa.com. 
 

Installation Guide 
UPCI board installation can be divided into six steps as follows: 

Step 1: Select serial transmission mode. 

For certain models, you will need to set onboard DIP switches to select the serial transmission 
mode for each port. This applies to the CP-118U-I, CP-138U-I, CP-118U, CP-138U, CP-114UL, CP-
114UL-I, CP-134U, CP-134U-I, CP-112UL, CP-112UL-I, CP-132UL, CP-132UL-I, and POS-104UL. 
For details, refer to Chapter 2. 

Step 2: Install board. 

UPCI boards are installed in an open PCI or PCI-X expansion slot on the PC. For details, refer to 
Chapter 2. 

Step 3: Install drivers and configure board 

For details, refer to Chapters 3. 

Step 4: Connect your serial devices to the board’s serial ports 

For details, refer to Chapter 6. 

Step 5: Restart system and verify driver initialization 

For details, refer to Chapters 3. 

Step 6: Develop and run your serial communication application 

For details, refer to Chapter 5. 

 

https://www.moxa.com/
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2. Hardware Installation 

Overview 
This chapter explains the hardware installation procedure in detail. Since the BIOS automatically assigns the 
IRQ number and I/O addresses, you will need to install the board before you install the drivers. You can 
install up to 8 UPCI boards in one system, as long as sufficient I/O address and IRQ number resources are 
available. 

Configuring the Board and Dimension 

8 Ports 

CP-118U/CP-118U-I 
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Onboard termination resistors can be activated individually for each serial port using jumpers JP1 through 
JP8. For CP-118U-I, JP1/2/3/4/5/6/7/8 corresponds to serial port 1/2/3/4/5/6/7/8, respectively. For CP-
118U, JP1/2/3/4/5/6/7/8 corresponds to serial port 8/7/6/5/4/3/2/1, respectively. Short the jumper pins to 
activate the termination resistor; leave the jumper pins open to bypass the termination resistor. 

The onboard DIP switches, S1, S2, and S3, are used to select RS-232, RS-422, or RS-485 mode for each 
serial port. There are 8 switches on each bank corresponding to the 8 serial ports. S3 selects between RS-
232 and RS-422/485, S2 selects between RS-422 and RS-485, and S1 selects between 2-wire and 4-wire 
RS-485, as follows: 

Mode S1 S2 S3 
RS-232 – – ON 
RS-422 – ON OFF 

4-wire RS-485 ON OFF OFF 
2-wire RS-485 OFF OFF OFF 
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CP-138U/CP-138U-I 

 

 

Onboard termination resistors can be activated individually for each serial port using jumpers JP1 through 
JP8. For CP-138U-I, JP1/2/3/4/5/6/7/8 corresponds to serial port 1/2/3/4/5/6/7/8, respectively. For CP-
138U, JP1/2/3/4/5/6/7/8 corresponds to serial port 8/7/6/5/4/3/2/1, respectively. Short the jumper pins to 
activate the termination resistor; leave the jumper pins open to bypass the termination resistor. 

The onboard DIP switches, S1 and S2, are used to select RS-422 or RS-485 mode for each serial port. There 
are 8 switches on each bank corresponding to the 8 serial ports. S2 selects between RS-422 and RS-485; 
S1 selects between 2-wire and 4-wire RS-485, as follows: 

Mode S1 S2 
RS-422 – ON 

4-wire RS-485 ON OFF 
2-wire RS-485 OFF OFF 
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CP-168U 

 

This board does not require configuration. 

4 Ports 

CP-114UL/CP-114UL-I 
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Onboard termination resistors can be activated individually for each serial port using jumpers JP1 through 
JP4. For CP-114UL, JP1/2/3/4 corresponds to serial port 1/2/3/4, respectively. For CP-114UL-I, JP1/2/3/4 
corresponds to serial port 4/3/2/1, respectively. Short the jumper pins to activate the termination resistor; 
leave the jumper pins open to bypass the termination resistor. 

The onboard DIP switches, S1, S2, and S3, are used to select RS-232, RS-422, or RS-485 mode for each 
serial port. Switches 1 through 4 on each bank correspond to the four serial ports. S3 selects between RS-
232 and RS-422/485, S2 selects between RS-422 and RS-485, and S1 selects between 2-wire and 4-wire 
RS-485, as follows: 

Mode S1 S2 S3 
RS-232 – – ON 
RS-422 – ON OFF 

4-wire RS-485 ON OFF OFF 
2-wire RS-485 OFF OFF OFF 

CP-134U/CP-134U-I 
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Onboard termination resistors can be activated individually for each serial port using jumpers JP1 through 
JP4. For CP-134U, JP1/2/3/4 corresponds to serial port 1/2/3/4, respectively. For CP-134U-I, JP1/2/3/4 
corresponds to serial port 4/3/2/1, respectively. Short the jumper pins to activate the termination resistor; 
leave the jumper pins open to bypass the termination resistor. 

The onboard DIP switches, S1 and S2, are used to select RS-422 or RS-485 mode for each serial port. 
Switches 1 through 4 on each bank correspond to the 4 serial ports. S2 selects between RS-422 and RS-
485; S1 selects between 2-wire and 4-wire RS-485. In addition, ports 1 and 2 can be set individually to RS-
232 mode using the on-board 30-pin jumpers, as follows: 

  
RS-422 or RS-485 mode: 
Use the jumper to cover the left 
two columns of jumper pins. 

RS-232 mode: 
Use the jumper to cover the right 
two columns of jumper pins. 
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CP-104UL 

 

This board does not require configuration. 

CP-104JU 

 

This board does not require configuration. 
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POS-104UL 

 

The onboard jumpers are used to specify the pin 9 power signal for each serial port. 

Step A: 
The top row of jumper pins selects the source of 12V power; 
the bottom row of jumper pins selects the source of 5V power: 

Bus power External power 

  
 

If the 5V or 12V external power is enabled, you will need to connect the cable from the back of the POS-
104UL to the PC’s power supply. Remove both jumpers to disable all power signals to all ports. 

Step B: 
For each serial port, a set of 5 jumper pins is 
used to select the power signal that is sent to  
pin 9. 

5V 12V RI signal (input) 

   
 

To disable pin 9 power signals for a specific port, remove the jumper. 
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2 Ports 

CP-112UL/CP-112UL-I 

 

 

Onboard termination resistors can be activated individually for each serial port using jumpers JP1 and JP2. 
JP1 corresponds to serial port 1. Short the jumper pins to activate the termination resistor; leave the 
jumper pins open to bypass the termination resistor. The onboard DIP switches, S1, S2, and S3, are used to 
select RS-232, RS-422, or RS-485 mode for each serial port. Switch 1 corresponds to port 1 and switch 2 
corresponds to port 2. S1 selects between RS-232, S2 selects between RS-422, and S3 selects between 2-
wire and 4-wire RS-485, as follows: 

Mode S1 S2 S3 
RS-232 ON – – 
RS-422 OFF ON – 

4-Wire RS-485 OFF OFF ON 
2-Wire RS-485 OFF OFF OFF 
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CP-132UL/CP-132UL-I 

 

 

Onboard termination resistors can be activated individually for each serial port using jumpers JP1 and JP2. 
JP1 corresponds to serial port 1. Short the jumper pins to activate the termination resistor; leave the 
jumper pins open to bypass the termination resistor. 

The onboard DIP switches, S1 and S2, are used to select RS-422 or RS-485 mode for each serial port. On 
each bank, switch 1 corresponds to port 1 and switch 2 corresponds to port 2. S2 selects between RS-422 
and RS-485; S1 selects between 2-wire and 4-wire RS-485. 
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CP-102UL 

 

This board does not require configuration. 

CP-102U 

 

This board does not require configuration. 
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Plugging the Board Into an Expansion Slot 

 ATTENTION 
 Safety First! 

 To avoid damaging your system and board, make sure your PC’s power is turned off before installing your 
Universal PCI Board. 

 

Step 1: Power off the PC. 

Step 2: Shut off the power to any peripheral devices and remove the PC’s cover. 

Step 3: Configure the UPCI board’s DIP switches and jumpers as necessary. This applies only to certain 
models. For additional information, refer to your model in this chapter.  

Step 4: Insert the board firmly into a free PCI or PCI-X slot on the PC. 

Step 5: Use a screw to secure the board in place. 

Step 6: Replace the PC’s cover. 

Step 7: Power on the PC. The BIOS will automatically set the IRQ and I/O address. 

Step 8: Install the software. For details, refer to the appropriate chapter for your operating system. 
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3. Software Installation 

This chapter gives installation, configuration, and update/removal procedures for the driver for Windows 
2000, Windows 2003/XP/Vista/2008 (32-bit/64-bit), Windows 7/8/8.1/10 (32-bit/64-bit), Windows Server 
2008 R2/2012/2012 R2/2016 (x64), WinCE, DOS, Linux (32-bit/64-bit), and SCO. Before proceeding with 
the software installation, complete the hardware installation discussed in the previous chapter, “Hardware 
Installation.” 

Refer to the next chapter, “Serial Programming Tools,” for information about developing your own serial 
programming applications. Note that you can install up to 8 Universal PCI boards in one system, provided 
sufficient I/O address and IRQ number resources are available. 

You can download the drivers from the Moxa website. 

Windows Drivers 
Moxa provides drivers that allow you to use the following serial board products for a variety of Windows 
platforms. 

The overall procedure for installing the 
drivers is shown on the right. The operating 
system will automatically detect a newly 
installed board. 
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Windows 2000, 2003/XP/Vista/2008 (x86/x64), 7/8/8.1/ 
10 (x86/x64), Server 2008 R2/2012/2012 R2/2016 (x64) 

We will take Windows 7 (x64) as an example, which procedure is similar to the other Windows platforms, to 
describe how to install, configure, check the port status, remove, or uninstall the UPCI cards.  

The following topics are included: 

• Installing the Driver 

• Configuring the Ports 

• Checking the Status 

• Removing the Driver 

• Uninstalling the Driver 

Installing the Driver 
In this part, we will describe how to install the UPCI cards for the first time with Windows 7. First, make 
sure that you have already plugged the board or boards into the system’s UPCI slot(s). 

 NOTE 
 If you have already installed a Moxa UPCI board in your computer, and you are installing additional 

boards, then Windows 7 will automatically detect and install the new board(s) the next time you boot up 
the computer. In this case, proceed directly to the next section, “Configuring the Ports,” to configure the 
ports’ serial transmission parameters. 

 

Second, you may download the drivers at www.moxa.com. Based on the OS type, choose the corresponding 
driver. Then, follow the following procedures to install the driver.  

1. The Setup Wizard will open. Click Next to install the driver. 
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2. Read the license agreement. If you agree, click Next to move on.  

 

3. Click Next to install the driver in the indicated folder, or use the drop-down menu to locate a different 
folder. 
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4. Click Install to proceed with the installation. 

 

5. Click Finish to complete the installation of the driver. 

 

Configuring the Port 
After the driver has been installed, use the Device Manager to configure the serial ports of your UPCI cards. 
(CP-118U will be used as an example). 

In this section, we describe how to access MOXA Smartio/Industio Windows Driver and guide you on how to 
do the serial port configuration. 

• Accessing MOXA Smartio/Industio Window Driver 

• Configuring Serial Port  

 Port Number 

 Rx, TX FIFO 
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Accessing MOXA Smartio/Industio Window Driver 
Expand the Multi-port serial adapters tab, right-click Moxa UPCI model, e.g., CP-118U Series (PCI 
Bus), and then click Properties to open the board’s configuration panel.  

 

Configuring the Serial Ports 

Port Number 
1. Click the port you would like to configure to highlight it and then click Port Setting.  
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2. Select a COM number for the port from the Port Number drop-down menu. Select the Auto 
Enumerating COM Number option to map subsequent ports automatically. The port numbers will be 
assigned in sequence. For example, if COM 1 is assigned to Port 1, then COM 2 (if not already occupied) 
will be assigned to Port 2, etc. 

 

Rx, Tx FIFO 
1. Select an Rx FIFO trigger from the Rx FIFO Level drop-down menu. Rx FIFO triggers levels range 

from 1 byte to 120 bytes, with the default set at 120 (High) bytes. Select the Set the change to all 
ports option to apply this Rx FIFO trigger to all ports. 

2. Select a Tx FIFO Level from the Tx FIFO Level drop-down menu. Tx FIFO Levels 1 byte to 128 bytes, 
with the default set at 128 (High) bytes. Select the Set the change to all ports option to apply the 
just defined Tx FIFO size to all ports. 
 Tx FIFO (Byte) Rx FIFO(Byte) 
High 128 120 
Middle 64 60 
Low 1 1 

3. Click OK to save the port settings and then click OK in the Property window to finish the port settings 
procedure. 

Checking the Status 
The PComm Diagnostic program is a useful tool for checking the status of Moxa’s multiport serial boards. 
The program can be used to test internal and external IRQ, TxD/RxD, UART, CTS/RTS, DTR/DSR, etc. Use 
this program to ensure that your Moxa boards and ports are working properly. 

To start the program, click Start > Programs > MOXA > PComm Ver 1.X > PComm Diagnostic. 
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 NOTE 
 Download the PComm Lite software for free from Moxa’s website at 

www.moxa.com/support/free_downloads.htm. 
 

Removing the Driver 
1. Open Device Manager and use the mouse to place the cursor over the MOXA CP-118U Series (UPCI Bus) 

under Multi-port serial adapters, right-click, and then select the Uninstall option. 

 

2. Select Delete the driver software for this device and click OK to proceed with uninstalling the 
board. 

 

  

file://Mhqsync01/mkt$/MKT_Cloud/Global_Marketing/Writer/Manuals/Universal_PCI/1---Manual/www.moxa.com/support/free_downloads.htm
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Uninstalling the Driver 
The MSB driver may be removed through Add/Remove Programs in the Windows Control Panel. Click 
Uninstall next to MOXA Smartio/Industio Windows Driver Verx.xx 
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Windows NT 

This section  explains how to install, configure, update, and remove the board drivers for Windows NT. The 
following models are supported: 

2 Ports 4 Ports 8 Ports 
CP-112UL/CP-112UL-I CP-114UL/CP-114UL-I CP-118U/CP-118U-I 
CP-132UL/CP-132UL-I CP-134U/CP-134U-I CP-138U/CP-138U-I 
CP-102UL CP-104UL CP-168U 
CP-102U CP-104JU  
CP-102UF POS-104UL  

Windows NT  supports up to 256 serial ports, from COM1 to COM256. Moxa developed pure 32-bit Windows 
device drivers in order to fully utilize the advanced multi-process and multi-thread features of Windows NT. 
The drivers conform to the Win32 COMM API standard.  

Download the drivers from the Moxa website. For information on developing your own serial programming 
applications, refer to Chapter 9. 

Before installing the software, be sure to install the hardware first. For details on installing the hardware, 
refer to Chapter 2. 
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Installing the Driver 
You will need to plug the board in an available PCI or PCI-X slot first, before installing the driver. Note that 
these instructions use the CP-168U as an example. The procedure for installing all models is the same. 

1. Log in to Windows NT as Administrator. 

Locate the appropriate folder for your board’s drivers on the Document & Software CD. The NT drivers 
will be located under the product folder in the \Software\WinNT directory (e.g., under \CP-118U 
Series\Software). Copy this folder to the PC’s hard disk and remember its location. 

In the Control Panel, open Network. On the Adapters tab, click Add. When prompted to select a 
product, click Have Disk…  

You will be prompted to enter the path to the driver. Enter the location of the drivers that you copied 
from the Document & Software CD (C:\Windows.nt in this example) and then click OK. 

 
2. When prompted, select your board model (Smartio/Industio Family multiport board in this 

example) and click OK. 
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3. After the files have been installed, a configuration panel will open. This is where boards are installed, 
configured, and removed. If another board has already been installed on the system, it will already be 
listed. Windows NT does not automatically detect Moxa UPCI boards, so you will need to click Add for a 
newly installed board. 

 

4. Under Board Type, select the UPCI board that is being installed. The window will show the COM 
settings for the serial ports on the board. Modify the COM settings for any port at this time by selecting 
a port and clicking Port Setting. If you are satisfied with the COM settings, click OK to return to the 
configuration panel. 
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5. The board will now appear in the configuration panel (CP-168U Series in this example). Click OK to 
return to the Network applet. After that, click OK again to exit the Network applet  

 

6. Restart the PC. After you have logged back into Windows NT, you may check the event log issued by 
the Moxa driver to see if the board’s ports have been initialized successfully. In the Administrative 
group, open Event Viewer and select Log and System. For each newly installed or configured Moxa 
UPCI board, check for a message stating that the board has been enabled (e.g., “Moxa CP-168U board, 
with first serial port COM3, has been enabled”). 

 ATTENTION 
 The driver configuration will not take effect until you restart the PC. 

 Double-check that all CP-168U board components are connected and fastened tightly to ensure that the 
system and the driver can start up successfully. 

 

Configuring the Ports 
1. In Windows Control Panel, open the Network applet. In the Adapters tab, UPCI boards will appear 

as a type of Moxa adapter (Moxa Smartio/Industio Family Adapter in this example). Select the 
Moxa adapter and click Properties…. 
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2. The configuration panel will open with a list of installed boards. Select your board and click Property. 
Up to four Moxa UPCI boards can be installed at a time. 

 

3. Select a port to configure and click Port Setting. 

 

4. Under Port Number, select a COM number to assign to the serial port. Select Auto Enumerating 
COM Number to map subsequent ports in numerical order. For example, if COM 3 is assigned to Port 1, 
then COM 4 will be automatically assigned to Port 2. 
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Select an Rx FIFO Trigger and Tx FIFO Size. The default Rx FIFO Trigger is 120 bytes (high level). 
The default Tx FIFO Size is 128 bytes (high level). Select Set the change to all ports to use this 
setting for all serial ports on the board. 
 Tx FIFO Rx FIFO 
High 128 120 
Middle 64 60 
Low 1 1 

5. Click OK to approve the settings for the selected port. Continue in the same way to configure the other 
ports. When you have finished setting up the ports, click OK to close the Properties window and apply 
the new port settings. Click OK again to exit the Network applet. 

 

Removing the Board 
To remove a board, shut of your PC and physically remove the board from the PCI slot. The next time you 
start up the PC, Windows NT will automatically remove the configuration. You do not need to go through the 
Windows control panel. 

Updating the Driver 
1. In Windows Control Panel, open the Network applet. In the Adapters tab, UPCI boards will appear 

as a type of Moxa adapter (Moxa Smartio/Industio Family Adapter in this example). Select the 
Moxa adapter and click Remove. 

 

2. Restart the system. Go through the process of installing the drivers using the new drivers. 
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Removing the Driver 
1. In Windows Control Panel, open the Network applet. In the Adapters tab, UPCI boards will appear 

as a type of Moxa adapter (Moxa Smartio/Industio Family Adapter in this example). Select the 
Moxa adapter and click Remove. 

 
2. Click OK to exit the Network applet and restart the system. 

Windows 95/98/ME 

This chapter explains how to install, configure, update, and remove the board drivers for Windows 
95/98/ME. The following models are supported: 

2 Ports 4 Ports 8 Ports 
CP-112UL/CP-112UL-I CP-114UL/CP-114UL-I CP-118U/CP-118U-I 
CP-132UL/CP-132UL-I CP-134U/CP-134U-I CP-138U/CP-138U-I 
CP-102UL CP-104UL CP-168U 
CP-102U CP-104JU  
CP-102UF POS-104UL  

Windows 95/98/ME supports up to 128 serial ports, from COM1 to COM128. In order to fully utilize the 
advanced multi-process and multi-thread features of Windows 95/98/ME, Moxa developed pure 32-bit 
virtual device port drivers (VxD) that are compliant with communication drivers (VCOMM). The drivers 
conform to the Win32 COMM API standard.  

Download the drivers from the Moxa website. For information on developing your own serial programming 
applications, refer to Chapter 9. 

Before installing the software, be sure to install the hardware first. For details on installing the hardware, 
refer to Chapter 2. 
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Installing the Driver 
The following instructions show how to install the driver for the first time under Windows 95/98/ME. You will 
need to plug the board into an available PCI or PCI-X slot first, before installing the driver. 

 ATTENTION 
 The following steps will not be necessary if a Moxa UPCI board was already installed on your computer. 

Windows will automatically detect and install any additional board(s) at bootup. In this case, you may 
proceed directly to configuring the ports. 

 

Windows 95 

1. After the board is physically installed and the PC boots up, Windows will automatically detect the new 
board and the Found New Hardware Wizard window will open. Click Next to continue. 

 

2. Select Other Locations… 
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3. Click Browse and select the appropriate directory on the Document & Software CD for the driver. 
Drivers for all operating systems are located under the product folder in the \Software directory (e.g., 
under \CP-168U \Software). Select the \Win9x folder and click OK to continue. 

 
4. After Windows finds the drivers, click Finish. 

 

 
5. You may begin configuring and using the new COM ports right away without restarting Windows.  

Windows 98 and ME 

1. After the board is physically installed and the PC boots up, Windows will automatically detect the new 
board, and the Found New Hardware Wizard window will open. Click Next to continue. 
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2. Select Display a list... and click Next. 

 

3. Select Other Devices and click Next. 

 

4. Select Have Disk… 
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5. Click Browse and select the appropriate directory on the Document & Software CD for the driver. 
Drivers for all operating systems are located under the product folder in the \Software directory (e.g., 
under \CP-168U\Software). Select the \Win9x folder and click OK to continue. 

 

6. After Windows installs the drivers, click Finish. 

 

Configuring the Ports 
You may configure the COM ports after the board and drivers have been installed. 

1. In the Windows Control Panel, open the System applet.  
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2. In the Device Manager tab, expand the Moxa Smartio/Industio multiport board category by 
clicking the “+” sign next to it. Select the desired board (CP-168U in this example) and click 
Properties. 

 
3. On the Ports Configuration tab, select a port to configure and click Port Setting.  
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4. Under Port Number, select a COM number to assign to the serial port. Select Auto Enumerating 
COM Number to map subsequent ports in numerical order. For example, if COM 3 is assigned to Port 1, 
then COM 4 will be automatically assigned to Port 2. 

 

Select an Rx FIFO Trigger and Tx FIFO Size. The default Rx FIFO Trigger is 120 bytes (high level). 
The default Tx FIFO Size is 128 bytes (high level). Select Set the change to all ports to use this 
setting for all serial ports on the board. 
 Tx FIFO Rx FIFO 
High 128 120 
Middle 64 60 
Low 1 1 

5. Click OK to approve the settings for the selected port. Continue in the same way to configure the other 
ports. When you have finished setting up the ports, click OK to close the Properties window and apply 
the new port settings. Click OK again to close the Device Manager and restart the system. 

Updating the Driver 
You may configure the COM ports after the board and drivers have been installed. 

1. In the Windows Control Panel, open the System applet.  
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2. In the Device Manager tab, expand the Moxa Smartio/Industio multiport board category by 
clicking the “+” sign next to it. Select the desired board (CP-168U in this example) and click 
Properties. 

 

3. In the Driver tab, click Update Driver.... 
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4. Select the appropriate model (CP-168U in this example) and click Have Disk... 

 

5. When prompted, select the appropriate directory on the Document & Software CD for the driver. Drivers 
for all operating systems are located under the product folder in the \Software directory (e.g., under 
\CP-118U Series\Software). Select the \Win9x folder and click OK to continue. 

6. You will be prompted to restart the system. The new drivers will be in effect the next time you restart. 

Removing the Driver 
1. In the Windows Control Panel, open the Add/Remove Programs applet. On the Install/Uninstall tab, 

select Moxa Smartio/Industio Driver and click Add/Remove. 
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2. When prompted, click Yes to confirm that you want to remove the driver. 

 

3. After the driver has been removed, click OK to return to the Add/Remove Programs applet. 

 

Windows CE 

Windows CE 5.0 
In this section, we explain how to install Moxa Universal PCI boards under WinCE 5.0. These instructions are 
intended for users who are familiar with the Windows CE Platform Builder 5.0 Toolkit, and would like to 
install one or more Moxa Tech products. Here, we give only the step-by-step installation instructions for the 
development environment. You will need to download the image file to the target host yourself. 

The CP-104UL board is used to illustrate the installation procedure. 

Installing the Driver 
The following procedure explains how to install the CP-104UL multiport serial module driver under WinCE. 

Obtain a copy of Moxa Tech WinCE 5.0 driver package and extract it to your computer. Double-click the 
Install package to copy the Mxser folder to %WINCEROOT%\PLATFORM\ automatically, and import the 
supported Moxa Tech products into the Folder. 

1. Start WinCE Platform Builder, select File, and open New Platform. 
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2. Enter a name for the workspace and press Next. 

 
3. When you see Board Support Packages, Design Template, Applications & Media, Networking & 

Communications, OBEX Server, select what you need to build your own environment. The 
Completing the New Platform Wizard window will open to indicate that it has finished creating a 
new platform. Click Finish to complete the setup. 
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4. Open Manage Catalog Items (File > Manage Catalog Items). In the Catalog > View > Catalog, 
browse to \Third Party\Device Drivers\ MOXA Smartio/Industio-PCI, PC/104-Plus. Right-click 
on the driver Prefix COM or Prefix MXU you would like to include and choose Add to OS Design. 

 NOTE 
 You can select either Prefix COM or Prefix MXU, but not both. 
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5. Prefix COM supports up to 10 ports, from COM0 to COM9. Prefix MXU supports more than 10 ports, so it 
is better for you to select Prefix MXU if you are not sure how many ports the device has. Otherwise, you 
will only be allowed to use one multiport serial board on the target host. 

 

6. After adding Moxa Tech drivers into your OS Design, a new project is automatically added to your 
workspace. The project name is mxserce5. The project can be accessed from File View (View > File 
View). The mxserce5 project contains a number of files used to configure the drivers included in your 
OS Design. 

 

 NOTE 
 If you would like to use “Terminal Emulator” tool, change mxserce5.reg and keyboard like below (This is 

only just for “one” “COM” port). Determine the number of ports, COM, and MXU and enter the correct 
information.  

 [HKEY_LOCAL_MACHINE\ExtModems\HayesCompat1] 
“Port”=”COM2:”  
“DeviceType”=dword:1  
“FriendlyName”=”Hayes Compatible on COM2:” 
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7. Finally, open Build OS, select Build and Sysgen, and be sure to click Copy Files to Release 
Directory After Build and Make Run-Time Image After Build. 

 

8. Finally, copy your image file to the target host. 

 NOTE 
 If you have created a Windows CE Platform Builder in the development environment, you can skip steps 2, 

3, and 4. 
 

Windows CE 6.0 
The following procedure explains how to install the CP-102U multiport serial board driver under WinCE 6.0. 

1. Obtain a copy of Moxa’s WinCE 6.0 driver and extract it to your computer. Double-click the install 
package to automatically install Mxser. 

2. Create a new project in Visual Studio 2005. 
In Visual Studio 2005, click File > New > Project and select “Platform Builder for CE 6.0.” Choose 
“OS Design” template and then click OK. 
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3. The CE 6.0 OS Design Wizard will start. Click “Next” to get the Board Support Packages page and 

select CEPC: x86. Click “Next” to continue. 
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4. On the Design Templates page, select your environment, for example, PDA Device. Click Next to 
continue. 
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5. On the Design Template Variants page, select your environment, for example, Mobile Handheld. Click 
Next to continue. 

 

6. On the Application & Media page, select your environment, .NET Compact Framework 2.0, 
ActiveSync, and Quarter VGA Resources-Portrait Mode, for example. Click Next to continue. 
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7. On the Networking & Communication page, select your environment, for example, TCP/IPv6 Support. 
Click Next to continue. 

 
8. When the OS Design Project Wizard Complete screen appears, click Finish. The catalog notification 

will pop up. Click Acknowledge to finish the project. 
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9. Open the project you created. Click Project at the top of the screen and select Add Existing 

Subproject. Specify the PCI MSB Mxser driver location with the subproject file mxserce6.pbpxml. 

 

 

  



 

 

Universal PCI Board User Manual 55 

10. After the subproject is added, you may configure the mxserce6.reg registry file with the location 
[HKEY_LOCAL_MACHINE\Drivers\BuiltIn\PCI\Template\MOXAPCICOM]. 

 

11. Configuring FIFO and index: Setting the FIFO registry value to 1 enables the FIFO function and 0 
disables it. The index allows you to define the initial COM port number in WinCE, but before using this 
function, make sure that the COM port numbers do not conflict. 

 
12. Open Build and select Advanced Build Commands and choose Build Sysgen. This operation will 

take you a few minutes. 
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13. After building sysgen, select Build and choose Make Run-Time Image to create the WinCE OS image. 
Finally, copy your image file to the target host. 

 

Non-Windows Driver 
Drivers are provided for DOS, Linux, and SCO. 

DOS 

Moxa DOS API-232 is a software package that can help you develop or debug serial communications 
programs. This section will show you how to install the package, how to set up the driver, and how to load 
or unload the driver. The following models are supported: 

2 Ports 4 Ports 8 Ports 
CP-112UL/CP-112UL-I CP-114UL/CP-114UL-I CP-118U/CP-118U-I 
CP-132UL/CP-132UL-I CP-134U/CP-134U-I CP-138U/CP-138U-I 
CP-102UL CP-104UL CP-168U 
CP-102U CP-104JU  
CP-102UF POS-104UL  
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Installing the Driver 
1. Run the installation program, DOSINST.EXE under \Software\DOS on the Document & Software CD. 

Specify the target directory for the API-232 files (e.g., C:\MOXA). Press F2 to start the installation. 

 

2. After installation is complete, you will be prompted to set up the board and driver initial values. It is 
strongly recommended that you set up the board and driver at this time by pressing Y. 
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Setting up the Driver 
The following instructions are not intended to illustrate every function of the setup program. For more 
detailed information, refer to the help files by pressing F1 in the setup program. 

1. Run the setup program, BIN\SETUP.EXE. 

Select your board model (CP-134U in this example) and press Enter. 

 

2. Press PgDn to view and change the setup options for the selected board.  

 

 

  



 

 

Universal PCI Board User Manual 59 

3. The settings for each port will be displayed. Verify the settings and make any necessary changes. 

 

Port number: This is the port ID of each port. Application software will refer to a port by its port 
number (ID). Port numbers must be unique; duplicate port numbers are not 
allowed. The port number can range from 0 to 255 as long as it does not overlap 
with another port. Generally, you should consider the convenience of programming 
when specifying the port number. 

TxD buffer size: This is the transmission (output) buffer allocated in the system for each port. 

RxD buffer size: This is the receiving (input) buffer allocated in the system for each port. 

F5: Group Edit: This allows you to configure several ports simultaneously as a group. 

 

4. Press F10 to save the latest configuration and exit the setup program. 
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Loading the Driver 
After setting up the driver, you must load the driver in order to gain access to the serial ports on the serial 
board. Run BIN\DP-DRV.EXE at the DOS prompt. The driver will detect your multiport serial board 
automatically. You should see messages indicating successful detection of your module, such as the 
following: 

Smartio/Industio Family DOS driver Version 1.9 
Setup driver . 
CP-134U series (Bus= x ,Dev=y) : OK! 
Device driver setup O.K. 

At this point, you can execute applications that support API-232 functions or start developing applications 
using the API-232 library. 

Unloading the Driver 
To unload or release the driver from memory, enter DP-DRV /Q at the DOS prompt. 

Linux (32-bit/64-bit) 

The Linux drivers support the following models: 

CP-102U CP-114UL CP-132UL-I  CP-138U-I 

CP-102UL CP-118U CP-134U  CP-168U  

CP-104JU  CP-118U-I CP-134U-I  POS-104UL 

CP-104UL  CP-132UL  CP-138U CP-102UF 

To install and load the Linux drivers, enter the following commands from the Linux prompt: 

# mkdir moxa 
# cd moxa 
# cp /<driver directory>/driv_linux_smart_<version>_build_<build_date>.tgz . # 
tar -zxvf driv_linux_smart_<version>_build_<build_date>.tgz 
# make clean; make install 
# cd /moxa/mxser/driver 
# ./msmknod 
# modprobe mxser 

If the driver has loaded successfully, you should see a message such as the following:  

MOXA Smartio/Industio family driver version 1.11 
Found MOXA CP-168U series board(BusNo=2,DevNo=13) 
ttyM0 – ttyM7 max. baudrate = 921600 bps 

You can verify that the driver has loaded by entering the following: 

# lsmode |grep mxser 

You should see a message such as the following: 

mxser 59484 0 

The installation will include msdiag, a diagnostic utility, msterm, a terminal emulation program, and 
msmon, a monitoring utility. For additional information, refer to readme.txt in the /home/moxa/mxser 
directory. 

SCO 

• SCO OpenServer 5 

• SCO OpenServer 6 

• SCO UnixWare 7 
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Follow the steps given in this section to install the SCO OpenServer 5/6 & SCO UnixWare 7 driver. The 
installation procedures for SCO UnixWare 7 and SCO OpenServer 5/6 are similar. 

1. Copy the driver file .tar to your host. 

2. #tar xvf <driver tar file> 
#/tmp/moxa/mxinstall 

3. The window shown below will open next. Press RETURN to continue. 

============================================================= 

Copyright© 2008 Moxa Inc. 

All Rights Reserved. 

Moxa Smartio/Industio Family Device Driver Installation (Ver. 1.11) 

============================================================= 

For SCO UnixWare 7 

Tar files, wait.....O.K. 

Press RETURN to continue 

4. <Note: If your environment is SCO OpenServer 5/6, you can skip step 4 & 5> 

When you see the screen below, select “Esc” to exit and reboot your computer. 

MOXA Smartio/Industio Family Installation Utility (Ver 1.11) 
 

Smartio/Industio Family Basic Configuration 
Board No. Board Type I/O Address Interrupt Bus/Dev No. 

1 None ------------ ------------ ------------ 
2 None ------------ ------------ ------------ 
3 None ------------ ------------ ------------ 
4 None ------------ ------------ ------------ 

PgDn: getty Setting 
Enter: Confirm Input Value 

 
Esc: Exit 
Tab: Change Item 

5. After rebooting your computer, key in “moxaadm”. You will see MAIN MENU. Select Basic 
Configuration. 

MAIN MENU 
Basic Configuration 
Advanced Configuration 
Interface Configuration 
Port Monitoring 
Terminal Emulation 
Driver Removal 
Exit 

6. When you see the following screen, press Enter to select the MOXA Multiport Serial Board you installed 
by port and by model. For example, if you installed the CP-104UL, you should select 4 ports and then 
CP-104UL. 

MOXA Smartio/Industio Family Installation Utility (Ver 1.11) 
 

Smartio/Industio Family Basic Configuration 
Board No. Board Type I/O Address Interrupt Bus/Dev No. 

1 None ------------ ------------ ------------ 
2 None ------------ ------------ ------------ 
3 None ------------ ------------ ------------ 
4 None ------------ ------------ ------------ 

PgDn: getty Setting 
Enter: Confirm Input Value 

 
Esc: Exit 
Tab: Change Item 

7. The board’s basic information, such as I/O address, Bus No., and Device No., will be shown. The SCO 
system will assign the resources automatically to the Universal PCI board you selected. 

8. Next, press “Esc” to exit and reboot your computer.  

9. Note, whenever you change a MAIN MENU item, you have to reboot your computer. 
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4. Serial Programming Tools 

Overview 
Moxa provides Windows serial programming libraries and troubleshooting utilities that are easy to use and 
powerful. Use these tools to reduce software development time.  

The serial communication library is useful for developing applications for data communications, remote 
access, data acquisition, and industrial control. It provides a simpler solution compared to the more complex 
Windows Win32 COMM API.  

PComm is a professional serial communication tool for Windows PCs. PComm includes the following 
features: 

• Useful utilities for diagnostics, port monitoring, and terminal emulation 

• Sample programs 

• Comprehensive help files 

Serial Programming Library 
The serial programming library assists you in developing serial communications programs for any COM port 
that complies with the Microsoft Win32 API. It facilitates the implementation of multi-process and multi-
thread serial communication programs and can remarkably reduce development time. 

The library provides a complete set of functions as well as various sample programs for Visual C++, Visual 
Basic, and Delphi. To view detailed descriptions of the available functions and sample programs, go to Start 
> Program > PComm Lite and select PComm Lib Help, PComm Porting Notes, or PComm 
Programming Guide. You may also refer to the sample programs in the PComm directory. 

PComm Utilities 
This section provides brief descriptions of the PComm utilities. For more information about these utilities, 
refer to the Windows help files or to the API-232.txt file for DOS. 

Installation 

To install PComm, run Setup.exe from the Document and Software CD. Note that the PComm diagnostic 
and monitor utilities are for Moxa boards only. These two utilities will not work with other serial boards. 
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PComm Diagnostic 

PComm Diagnostic is designed for Moxa boards only. It provides internal and external testing of IRQ, 
TxD/RxD, UART, CTS/RTS, DTR/DSR, DTR/DCD, and other items. Use PComm Diagnostic to check the 
operation of both software and hardware. 

 

To run the Diagnostic program, go to Start > Program > PComm Lite > Diagnostic. 

PComm Monitor 

PComm Monitor is designed for Moxa boards in Windows NT only. It allows you to monitor data transmission 
of selected Moxa COM ports. It monitors data transmission, throughput, and line status at regular intervals. 
Click on a specific port to view that port’s communication parameters and status. 

To run PComm Monitor, go to Start > Program > PComm Lite > Monitor. 
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PComm Terminal Emulator 

PComm Terminal Emulator can be used to connect to a serial port to verify that data transmission is 
functioning correctly. It supports multiple windows and both VT100 and ANSI terminal types. You can 
interactively transfer data, periodically send patterns, and transfer files using ASCII, XMODEM, YMODEM, 
ZMODEM, and KERMIT protocols. 

To run PComm Terminal Emulator, go to Start > Program > PComm Lite > Terminal Emulator. 
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5. Smartio/Industio Programming Guide 

If you want to develop your own driver, no matter whether it is on a Windows or Linux platform, the Moxa 
Smartio/Industio Programming Guide is a useful instruction. 

Relative Product List 
See the “Moxa Board PCI Device ID List” at the end of this chapter. 

Resource Requirements for Moxa Board 
IRQ* 1 

I/O:  
UART register : 64 bytes ( 8 bytes / port * 8port )  for MU860 
                       4096 bytes ( 512 bytes / port * 8port ) for MUE250/450/850 
IRQ Vector register : 16 bytes ( only 1 byte used ) 

PCI Configuration for Moxa Board 
A. MOXA Vendor ID: 0x1393 

B. Device ID: See “Moxa Board PCI Device ID List” at the end of this chapter. 

C. Hardware resource on the Device Configuration Register of the PCI configuration space: 

Resource Name Chip Address Offset Size 
IRQ All 0x3C  
IRQ Vector Address MU860 0x1C BAR3 16 bytes 
UART register  
(I/O Base Address) 

MU860 0x18 BAR2 64 bytes 

UART register  
(Memory Base Address) 

MUE250, MUE450, MUE850 0x14 BAR1 4096 bytes 

Vector Base Address MUE250, MUE450, MUE850 0x18 BAR2 16 bytes 
 

Byte Offset 0-7 8-15 16-23 24-31 
00h Vendor ID Device ID 
04h Command Status 
08h … 
0Ch … 
10h BAR0 
14h BAR1 
18h BAR2 
1Ch BAR3 
… … 

3Ch Interrupt Line Interrupt Pin Reserved 
… … 

 NOTE 
 For MUE250, MUE450, and MUE850 chips only: Memory mode is recommended for these chips to access 

UART. To use memory mode, the driver must access the memory base address, which is at BAR1. 
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UART Register Structure for MU860 Chip 

 

 NOTE 
 For a detailed UART register description, see “UART Datasheet” section. 
 

UART register address = I/O base address + (port-1) *8 
For example, if the base address is 0x180: 

• The first port’s UART register I/O address is 0x180+(1-1)*8 = 0x180 

The first registered I/O address is 0x180, 

The second registered I/O address is 0x181, ….. 

• The second port’s UART register I/O address is 0x180+(2-1)*8 = 0x188 

The first registered I/O register is 0x188, 

The second registered I/O register is 0x189, ….. 

IRQ Vector Register Structure 

 

Bit Value Status 
0 Interrupt pending. Read the UART register to get the detailed interrupted information *. 
1 No interruption pending. 

All serial ports on the same Moxa board use the same IRQ. Check Vector to determine which port issues 
the interruptions. You can also get the information by querying the IIR of each port. 
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UART Register Structure for MUE250, MUE450, and MUE850 Chips 
There are 512 bytes for each UART register and an offset of 0x200 between each port. However, there is 
one exception: for the models that are 4-port boards, such as CP-104EL-A, CP-114EL, CP-114EL-I, and 
CP-134EL-A, the offset of the fourth UART register is 0xE00. 

  
Registers for 8 ports Registers for 4 ports 

 NOTE 
 For a detailed UART register description, see the “UART Datasheet” section. 
 

UART register address = I/O base address + (port-1) * 0x200 
For example, if the base address is 0x200: 

• The first port’s UART register I/O address is 0x200 + (1-1) * 0x200 = 0x200 

The first registered I/O address is 0x200, 

The second registered I/O address is 0x201, ….. 

• The second port’s UART register I/O address is 0x200 + (2-1) * 0x200 = 0x400 

The first registered I/O address is 0x400, 

The second registered I/O address is 0x401, ….. 

 NOTE 
 For the CP-104EL-A, CP-114EL, CP-114EL-I, and CP-134EL-A only: 

 The first port’s UART registered address: I/O base address 

 The second port’s UART registered address: I/O base address + 1 * 0x200 

 The third port’s UART registered address: I/O base address + 2 * 0x200 

 The fourth port’s UART registered address : I/O base address + 7 * 0x200 
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Control Serial Interface and Termination Resistor for MUE Chips 
For Moxa boards that use MUE250, MUE450, and MUE850 chips, BAR2, which is allocated 16 bytes, is the 
vector base address that can be used to control serial interface and termination resistor, according to the 
following table: 

Offset Bit Port # Parameters 

0x4 
[3..0] 1 

0x0 : RS-232 
0x1 : RS-422 
0xF : RS-485 2W 
0xB : RS-485 4W 

[7..4] 2 

0x5 
[3..0] 3 
[7..4] 4 

0x6 
[3..0] 5 
[7..4] 6 

0x7 
[3..0] 7 
[7..4] 8 

0x8 [7..0] [8..1] GPIO – Input 

0x9 [7..0] [8..1] 
GPIO direction configuration 
0 : Set GPIO direction to input 
1 : Set GPIO direction to output 

0xA [7..0] [8..1] 
GPIO – Output (Termination Resistor) 
0 : Low (0 Ohm) 
1 : High (120 Ohm) 

The interface of 4-port models, such as CP-114EL and CP-114EL-I., is using the following offset to set the 
interface of port 4. 

Offset Bit Port # Parameters 

0x4 
[3..0] 1 

0x0 : RS-232 
0x1 : RS-422 
0xF : RS-485 2W 
0xB : RS-485 4W 

[7..4] 2 

0x5 
[3..0] 3 
[7..4] – 

0x6 
[3..0] – 
[7..4] – 

0x7 [3..0] 4 

For Baud Rate Setting 
For General PC Com Port: CLK=1.8432MHz 
                                      Div = CLK/ (Baud x 16) 

But for Moxa Board: CLK=14.7456MHz 
                              Div = CLK/ (Baud x 16) 
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Moxa Board PCI Device ID List 
Model Ports Bus Chip Max Baud Vendor ID Device ID 
CP-102U 2 UPCI MU860 921.6k 0x1393 0x1022 
CP-102UL 2 UPCI MU860 921.6k 0x1393 0x1021 
CP-132UL 2 UPCI MU860 921.6k 0x1393 0x1321 
CP-132UL-I 2 UPCI MU860 921.6k 0x1393 0x1321 
CP-102E 2 PCIe MUE250 921.6k 0x1393 0x1024 
CP-102EL 2 PCIe MUE250 921.6k 0x1393 0x1025 
CP-132EL 2 PCIe MUE250 921.6k 0x1393 0x1322 
CP-132EL-I 2 PCIe MUE250 921.6k 0x1393 0x1322 
CP-104UL 4 UPCI MU860 921.6k 0x1393 0x1041 
CP-104JU 4 UPCI MU860 921.6k 0x1393 0x1042 
CP-114UL 4 UPCI MU860 921.6k 0x1393 0x1143 
CP-114UL-I 4 UPCI MU860 921.6k 0x1393 0x1143 
CP-134U 4 UPCI MU860 921.6k 0x1393 0x1340 
CP-134U-I 4 UPCI MU860 921.6k 0x1393 0x1340 
CP-104EL-A 4 PCIe MUE450 921.6k 0x1393 0x1045 
CP-114EL 4 PCIe MUE450 921.6k 0x1393 0x1144 
CP-114EL-I 4 PCIe MUE450 921.6k 0x1393 0x1144 
CP-134EL-A 4 PCIe MUE450 921.6k 0x1393 0x1342 
CB-114 4 PC/104-Plus MU860 921.6k 0x1393 0x1142 
CB-134I 4 PC/104-Plus MU860 921.6k 0x1393 0x1341 
CP-118U 8 UPCI MU860 921.6k 0x1393 0x1180 
CP-118U-I 8 UPCI MU860 921.6k 0x1393 0x1180 
CP-138U 8 UPCI MU860 921.6k 0x1393 0x1380 
CP-138U-I 8 UPCI MU860 921.6k 0x1393 0x1380 
CP-168U 8 UPCI MU860 921.6k 0x1393 0x1681 
CP-116E-A(A) 8 PCIe MUE850 921.6k  0x1393 0x1160 
CP-116E-A(B) 8 PCIe MUE850 921.6k  0x1393 0x1161 
CP-118EL-A 8 PCIe MUE850 921.6k  0x1393 0x1182 
CP-118E-A-I 8 PCIe MUE850 921.6k  0x1393 0x1183 
CP-138E-A-I 8 PCIe MUE850 921.6k  0x1393 0x1381 
CP-168EL-A 8 PCIe MUE850 921.6k 0x1393 0x1683 
CB-108 8 PC/104-Plus MU860 921.6k 0x1393 0x1080 

UART Datasheet 
Moxa’s chips are compatible with the following chips. For more details about the UART register description, 
refer to the downloaded links below. 

UART Port Datasheet 
MU-860 2-8 TL16C550C 
MUE-250 2 PI7C9X7952 
MUE-450 4 PI7C9X7954 
MUE-850 8 PI7C9X7958 

http://www.ti.com/lit/ds/symlink/tl16c550c.pdf
http://www.diodes.com/assets/Datasheets/PI7C9X7952.pdf
http://www.diodes.com/assets/Datasheets/PI7C9X7954.pdf
http://www.diodes.com/assets/Datasheets/PI7C9X7958.pdf
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6. Pin Assignments 

Overview 
This chapter provides the pin assignments for each Moxa UPCI multiport serial board, as well as the pin 
assignments for the optional accessories. Except for the CP-102U and CP-102UF, which have two built-in 
DB9 (male) serial connectors and an ST type fiber connector, respectively, Moxa’s UPCI boards do not have 
built-in serial port connectors. For all other models, you will need a cable or other accessory with standard 
serial connectors in order to connect serial devices to the board. The following chart shows the available 
cables and accessories for each model. 

Model Board Connector Supported Accessories Serial Connectors 
CP-102U 2×DB9 (male) --- --- 
CP-102UL  
CP-112UL 
CP-112UL-I 
CP-132UL  
CP-132UL-I  

DB25 (female) CBL-M25M9x2-50 2×DB9 (male) 

CP-104UL  
CP-114UL 
CP-114UL-I 
CP-134U  
CP-134U-I  

DB44 (female) 

CBL-M44M9x4-50 4×DB9 (male) 

CBL-M44M25x4-50 4×DB25 (male) 

CP-104JU  RJ45 
CBL-RJ45M9-150 4×DB9 (male) 
CBL-RJ45M25-150 4×DB25 (male) 

CP-118U 
CP-138U 
CP-168U  

DB62 (female) 

OPT8-M9 
CBL-M62M9x8-100 (OPT8D) 

8×DB9 (male) 

OPT8B 
CBL-M62M25x8-100 (OPT8C) 

8×DB25 (male) 

OPT8A, OPT8S, OPT8F, OPT8Z, OPT8K, 
OPT8I 

8×DB25 (female) 

OPT8-RJ45* 8×RJ45 
CP-118U-I 
CP-138U-I 

DB78 (female) 
CBL-M78M9x8-100 8×DB9 (male) 
CBL-M78M25x8-100 8×DB25 (male) 

POS-104UL DB44 (female) CBL-M44M9x4-50(POS) 4×DB9 (male) 
CP-102UF STx2 --- --- 

* The OPT8-RJ45 is designed for RS-232 only. It should only be used with the CP-118U in RS-232 mode or 
with the CP-168U. 

The serial connectors on each accessory use standard serial port pin assignments. Refer to the Serial 
Connectors section for details. 
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CP-102U 

 

This board supports RS-232 only. 

Model Board Connector Supported Accessories Serial Connectors 
CP-102U 2×DB9 (male) --- --- 

DB9 (Male): RS-232 
Pin Signal 
1 DCD 
2 RxD 
3 TxD 
4 DTR 
5 GND 
6 DSR 
7 RTS 
8 CTS 

CP-102UL 
This board supports RS-232 only. 

Model Board Connector Supported Accessories Serial Connectors 
CP-102UL  DB25 (female) CBL-M25M9x2-50 2×DB9 (male) 

DB25 (Female): RS-232 
Pin Signal Pin Signal 
1 – 14 – 
2 DCD1 15 DTR1 
3 GND 16 DSR1 
4 CTS1 17 RTS1 
5 RxD1 18 TxD1 
6 – 19 – 
7 – 20 – 
8 – 21 DCD0 
9 DTR0 22 GND 
10 DSR0 23 CTS0 
11 RTS0 24 RxD0 
12 TxD0 25 – 
13 – – – 



 

 

Universal PCI Board User Manual 72 

CP-104JU 

 

This board supports RS-232 only. 

Model Board Connector Supported Accessories Serial Connectors 

CP-104JU  RJ45 
CBL-RJ45M9-150 4×DB9 (male) 
CBL-RJ45M25-150 4×DB25 (male) 

8-pin RJ45: RS-232 
Pin Signal 
1 DSR 
2 RTS 
3 GND 
4 TxD 
5 RxD 
6 DCD 
7 CTS 
8 DTR 
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CP-104UL 
This board supports RS-232 only. 

Model Board Connector Supported Accessories Serial Connectors 

CP-104UL  DB44 (female) 
CBL-M44M9x4-50 4×DB9 (male) 
CBL-M44M25x4-50 4×DB25 (male) 

DB44 (Female): RS-232 
Pin Signal Pin Signal Pin Signal 
1 TxD3 16 CTS3 31 DCD3 
2 RxD3 17 DTR3 32 – 
3 RTS3 18 DSR3 33 GND 
4 – 19 – 34 – 
5 TxD2 20 CTS2 35 DCD2 
6 RxD2 21 DTR2 36 – 
7 RTS2 22 DSR2 37 GND 
8 – 23 – 38 – 
9 TxD1 24 CTS1 39 DCD1 
10 RxD1 25 DTR1 40 – 
11 RTS1 26 DSR1 41 GND 
12 – 27 – 42 DCD0 
13 TxD0 28 CTS0 43 – 
14 RxD0 29 DTR0 44 GND 
15 RTS0 30 DSR0 – – 

CP-112UL 
This board supports RS-232, RS-422, and RS-485 (both 2 and 4-wire). 

Model Board Connector Supported Accessories Serial Connectors 
CP-112UL DB25 (female) CBL-M25M9x2-50 2×DB9 (male) 

DB25 (Female): RS-232 
Pin Signal Pin Signal 
1 – 14 – 
2 DCD1 15 DTR1 
3 GND 16 DSR1 
4 CTS1 17 RTS1 
5 RxD1 18 TxD1 
6 – 19 – 
7 – 20 – 
8 – 21 DCD0 
9 DTR0 22 GND 
10 DSR0 23 CTS0 
11 RTS0 24 RxD0 
12 TxD0 25 – 
13 – – – 

 

  



 

 

Universal PCI Board User Manual 74 

DB25 (Female): RS-422 
Pin Signal Pin Signal 
1 – 14 – 
2 TxD1-(A) 15 RxD1-(A) 
3 GND1 16 – 
4 – 17 – 
5 TxD1+(B) 18 RxD1+(B) 
6 – 19 – 
7 – 20 – 
8 – 21 TxD0-(A) 
9 RxD0-(A) 22 GND0 
10 – 23 – 
11 – 24 TxD0+(B) 
12 RxD0+(B) 25 – 
13 – – – 

DB25 (Female): RS-485 (4-wire) 
Pin Signal Pin Signal 
1 – 14 – 
2 TxD1-(A) 15 RxD1-(A) 
3 GND1 16 – 
4 – 17 – 
5 TxD1+(B) 18 RxD1+(B) 
6 – 19 – 
7 – 20 – 
8 – 21 TxD0-(A) 
9 RxD0-(A) 22 GND0 
10 – 23 – 
11 – 24 TxD0+(B) 
12 RxD0+(B) 25 – 
13 – – – 

DB25 (Female): RS-485 (2-wire) 
Pin Signal Pin Signal 
1 – 14 – 
2 – 15 Data1-(A) 
3 GND1 16 – 
4 – 17 – 
5 – 18 Data1+(B) 
6 – 19 – 
7 – 20 – 
8 – 21 – 
9 Data0-(A) 22 GND0 
10 – 23 – 
11 – 24 – 
12 Data0+(B) 25 – 
13 – – – 
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CP-114UL 
This board supports RS-232, RS-422, and RS-485 (both 2 and 4-wire). 

Model Board Connector Supported Accessories Serial Connectors 

CP-114UL DB44 (female) 
CBL-M44M9x4-50 4×DB9 (male) 
CBL-M44M25x4-50 4×DB25 (male) 

DB44 (Female): RS-232 
Pin Signal Pin Signal Pin Signal 
1 TxD3 16 CTS3 31 DCD3 
2 RxD3 17 DTR3 32 – 
3 RTS3 18 DSR3 33 GND 
4 – 19 – 34 – 
5 TxD2 20 CTS2 35 DCD2 
6 RxD2 21 DTR2 36 – 
7 RTS2 22 DSR2 37 GND 
8 – 23 – 38 – 
9 TxD1 24 CTS1 39 DCD1 
10 RxD1 25 DTR1 40 – 
11 RTS1 26 DSR1 41 GND 
12 – 27 – 42 DCD0 
13 TxD0 28 CTS0 43 – 
14 RxD0 29 DTR0 44 GND 
15 RTS0 30 DSR0 – – 

DB44 (Female): RS-422, RS-485 (4-wire) 
Pin Signal Pin Signal Pin Signal 
1 RxD3+(B) 16 – 31 TxD3-(A) 
2 TxD3+(B) 17 RxD3-(A) 32 – 
3 – 18 – 33 GND 
4 – 19 – 34 – 
5 RxD2+(B) 20 – 35 TxD2-(A) 
6 TxD2+(B) 21 RxD2-(A) 36 – 
7 – 22 – 37 GND 
8 – 23 – 38 – 
9 RxD1+(B) 24 – 39 TxD1-(A) 
10 TxD1+(B) 25 RxD1-(A) 40 – 
11 – 26 – 41 GND 
12 – 27 – 42 TxD0-(A) 
13 RxD0+(B) 28 – 43 – 
14 RxD0-(A) 29 RxD0-(A) 44 GND 
15 – 30 – – – 
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DB44 (Female): RS-485 (2-wire) 
Pin Signal Pin Signal Pin Signal 
1 Data3+(B) 16 – 31 – 
2 – 17 Data3-(A) 32 – 
3 – 18 – 33 GND 
4 – 19 – 34 – 
5 Data2+(B) 20 – 35 – 
6 – 21 Data2-(A) 36 – 
7 – 22 – 37 GND 
8 – 23 – 38 – 
9 Data1+(B) 24 – 39 – 
10 – 25 Data1-(A) 40 – 
11 – 26 – 41 GND 
12 – 27 – 42 – 
13 Data0+(B) 28 – 43 – 
14 – 29 Data0-(A) 44 GND 
15 – 30 – – – 
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CP-118U 

 

This board supports RS-232, RS-422, and RS-485 (both 2 and 4-wire). 

Model Board Connector Supported Accessories Serial Connectors 

CP-118U DB62 (female) 

OPT8-M9 
CBL-M62M9x8-100 (OPT8D) 

8×DB9 (male) 

OPT8B 
CBL-M62M25x8-100 (OPT8C) 

8×DB25 (male) 

OPT8A, OPT8S 8×DB25 (female) 
OPT8-RJ45* 8×RJ45 

* The OPT8-RJ45 is designed for RS-232 only. It should only be used with the CP-118U in RS-232 mode. 

DB62 (Female): RS-232 
Pin Signal Pin Signal Pin Signal 
1 TxD0 22 RxD0 43 CTS0 
2 DTR0 23 DSR0 44 RTS0 
3 RxD1 24 DCD0 45 GND 
4 DSR1 25 TxD1 46 CTS1 
5 DCD1 26 DTR1 47 RTS1 
6 TxD2 27 RxD2 48 CTS2 
7 DTR2 28 DSR2 49 RTS2 
8 RxD3 29 DCD2 50 GND 
9 DSR3 30 TxD3 51 CTS3 
10 DCD3 31 DTR3 52 RTS3 
11 RxD4 32 GND 53 CTS4 
12 DSR4 33 TxD4 54 RTS4 
13 DCD4 34 DTR4 55 GND 
14 TxD5 35 RxD5 56 CTS5 
15 DTR5 36 DSR5 57 RTS5 
16 RxD6 37 DCD5 58 GND 
17 DSR6 38 TxD6 59 CTS6 
18 DCD6 39 DTR6 60 RTS6 
19 RxD7 40 GND 61 CTS7 
20 DSR7 41 TxD7 62 RTS7 
21 DCD7 42 DTR7 – – 
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DB62 (Female): RS-422, RS-485 (4-wire) 
Pin Signal Pin Signal Pin Signal 
1 RxD0+(B) 22 TxD0+(B) 43 – 
2 RxD0-(A) 23 – 44 – 
3 TxD1+(B) 24 TxD0-(A) 45 GND 
4 – 25 RxD1+(B) 46 – 
5 TxD1-(A) 26 RxD1-(A) 47 – 
6 RxD2+(B) 27 TxD2+(B) 48 – 
7 RxD2-(A) 28 – 49 – 
8 TxD3+(B) 29 TxD2-(A) 50 GND 
9 – 30 RxD3+(B) 51 – 
10 TxD3-(A) 31 RxD3-(A) 52 – 
11 TxD4+(B) 32 GND 53 – 
12 – 33 RxD4+(B) 54 – 
13 TxD4-(A) 34 RxD4-(A) 55 GND 
14 RxD5+(B) 35 TxD5+(B) 56 – 
15 RxD5-(A) 36 – 57 – 
16 TxD6+(B) 37 TxD5-(A) 58 GND 
17 – 38 RxD6+(B) 59 – 
18 TxD6-(A) 39 RxD6-(A) 60 – 
19 TxD7+(B) 40 GND 61 – 
20 – 41 RxD7+(B) 62 – 
21 TxD7-(A) 42 RxD7-(A) – – 

DB62 (Female): RS-485 (2-wire) 
Pin Signal Pin Signal Pin Signal 
1 Data0+(B) 22 – 43 – 
2 Data0-(A) 23 – 44 – 
3 – 24 – 45 GND 
4 – 25 Data1+(B) 46 – 
5 – 26 Data1-(A) 47 – 
6 Data2+(B) 27 – 48 – 
7 Data2-(A) 28 – 49 – 
8 – 29 – 50 GND 
9 – 30 Data3+(B) 51 – 
10 – 31 Data3-(A) 52 – 
11 – 32 GND 53 – 
12 – 33 Data4+(B) 54 – 
13 – 34 Data4-(A) 55 GND 
14 Data5+(B) 35 – 56 – 
15 Data5-(A) 36 – 57 – 
16 – 37 – 58 GND 
17 – 38 Data6+(B) 59 – 
18 – 39 Data6-(A) 60 – 
19 – 40 GND 61 – 
20 – 41 Data7+(B) 62 – 
21 – 42 Data7-(A) – – 
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CP-118U-I 
This board supports RS-232, RS-422, and RS-485 (both 2 and 4-wire). 

Model Board Connector Supported Accessories Serial Connectors 

CP-118U-I DB78 (female) 
CBL-M78M9x8-100 8×DB9 (male) 
CBL-M78M25x8-100 8×DB25 (male) 

DB78 (Female): RS-232 
Pin Signal Pin Signal Pin Signal 
1 GND7 27 DTR5 53 CTS2 
2 TxD7 28 RTS4 54 DSR2 
3 – 29 DTR4 55 CTS1 
4 GND6 30 – 56 DSR1 
5 TxD6 31 RTS3 57 – 
6 GND5 32 DTR3 58 CTS0 
7 TxD5 33 RTS2 59 DSR0 
8 – 34 DTR2 60 DCD7 
9 GND4 35 – 61 RxD7 
10 TxD4 36 RTS1 62 DCD6 
11 GND3 37 DTR1 63 RxD6 
12 TxD3 38 RTS0 64 – 
13 – 39 DTR0 65 DCD5 
14 GND2 40 CTS7 66 RxD5 
15 TxD2 41 DSR7 67 DCD4 
16 GND1 42 – 68 RxD4 
17 TxD1 43 CTS6 69 – 
18 – 44 DSR6 70 DCD3 
19 GND0 45 CTS5 71 RxD3 
20 TxD0 46 DSR5 72 DCD2 
21 RTS7 47 – 73 RxD2 
22 DTR7 48 CTS4 74 – 
23 RTS6 49 DSR4 75 DCD1 
24 DTR6 50 CTS3 76 RxD1 
25 – 51 DSR3 77 DCD0 
26 RTS5 52 – 78 RxD0 
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DB78 (Female): RS-422, RS-485 (4-wire) 
Pin Signal Pin Signal Pin Signal 
1 GND7 27 RxD5-(A) 53 – 
2 RxD7+(B) 28 – 54 – 
3 – 29 RxD4-(A) 55 – 
4 GND6 30 – 56 – 
5 RxD6+(B) 31 – 57 – 
6 GND5 32 RxD3-(A) 58 – 
7 RxD5+(B) 33 – 59 – 
8 – 34 RxD2-(A) 60 TxD7-(A) 
9 GND4 35 – 61 TxD7+(B) 
10 RxD4+(B) 36 – 62 TxD6-(A) 
11 GND3 37 RxD1-(A) 63 TxD6+(B) 
12 RxD3+(B) 38 – 64 – 
13 – 39 RxD0-(A) 65 TxD5-(A) 
14 GND2 40 – 66 TxD5+(B) 
15 RxD2+(B) 41 – 67 TxD4-(A) 
16 GND1 42 – 68 TxD4+(B) 
17 RxD1+(B) 43 – 69 – 
18 – 44 – 70 TxD3-(A) 
19 GND0 45 – 71 TxD3+(B) 
20 RxD0+(B) 46 – 72 TxD2-(A) 
21 – 47 – 73 TxD2+(B) 
22 RxD7-(A) 48 – 74 – 
23 – 49 – 75 TxD1-(A) 
24 RxD6-(A) 50 – 76 TxD1+(B) 
25 – 51 – 77 TxD0-(A) 
26 – 52 – 78 TxD0+(B) 

DB78 (Female): RS-485 (2-wire) 
Pin Signal Pin Signal Pin Signal 
1 GND7 15 Data2+(B) 29 Data4-(A) 
2 Data7+(B) 16 GND1 30 – 
3 – 17 Data1+(B) 31 – 
4 GND6 18 – 32 Data3-(A) 
5 Data6+(B) 19 GND0 33 – 
6 GND5 20 Data0+(B) 34 Data2-(A) 
7 Data5+(B) 21 – 35 – 
8 – 22 Data7-(A) 36 – 
9 GND4 23 – 37 Data1-(A) 
10 Data4+(B) 24 Data6-(A) 38 – 
11 GND3 25 – 39 Data0-(A) 
12 Data3+(B) 26 – 40 – 
13 – 27 Data5-(A) 41 – 
14 GND2 28 – 42 – 
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CP-132UL, CP-132UL-I 
These boards support RS-422 and RS-485 (both 2 and 4-wire). 

Model Board Connector Supported Accessories Serial Connectors 
CP-132UL  
CP-132UL-I  

DB25 (female) CBL-M25M9x2-50 2×DB9 (male) 

DB25 (Female): RS-422 
Pin Signal Pin Signal 
1 – 14 CTS1-(A) 
2 TxD1-(A) 15 RxD1-(A) 
3 GND1 16 RTS1-(A) 
4 CTS1+(B) 17 RTS1+(B) 
5 TxD1+(B) 18 RxD1+(B) 
6 – 19 – 
7 – 20 – 
8 CTS0-(A) 21 TxD0-(A) 
9 RxD0-(A) 22 GND0 
10 RTS0-(A) 23 CTS0+(B) 
11 RTS0+(B) 24 TxD0+(B) 
12 RxD0+(B) 25 – 
13 – – – 

DB25 (Female): RS-485 (4-wire) 
Pin Signal Pin Signal 
1 – 14 – 
2 TxD1-(A) 15 RxD1-(A) 
3 GND1 16 – 
4 – 17 – 
5 TxD1+(B) 18 RxD1+(B) 
6 – 19 – 
7 – 20 – 
8 – 21 TxD0-(A) 
9 RxD0-(A) 22 GND0 
10 – 23 – 
11 – 24 TxD0+(B) 
12 RxD0+(B) 25 – 
13 – – – 
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DB25 (Female): RS-485 (2-wire) 
Pin Signal Pin Signal 
1 – 14 – 
2 – 15 Data1-(A) 
3 GND1 16 – 
4 – 17 – 
5 – 18 Data1+(B) 
6 – 19 – 
7 – 20 – 
8 – 21 – 
9 Data0-(A) 22 GND0 
10 – 23 – 
11 – 24 – 
12 Data0+(B) 25 – 
13 – – – 

CP-134U, CP-134U-I 
These boards support RS-422 and RS-485 (both 2 and 4-wire). Ports 1 and 2 also support RS-232. 

Model Board Connector Supported Accessories Serial Connectors 
CP-134U  
CP-134U-I  

DB44 (female) 
CBL-M44M9x4-50 4×DB9 (male) 
CBL-M44M25x4-50 4×DB25 (male) 

DB44 (Female): RS-232 (Ports 1 and 2 only) 
Pin Signal Pin Signal Pin Signal 
1 – 16 – 31 – 
2 – 17 – 32 – 
3 – 18 – 33 – 
4 – 19 – 34 – 
5 – 20 – 35 – 
6 – 21 – 36 – 
7 – 22 – 37 – 
8 – 23 – 38 – 
9 TXD1 24 CTS1 39 DCD1 
10 RXD1 25 DTR1 40 RI1 
11 RTS1 26 DSR1 41 GND 
12 – 27 – 42 DCD0 
13 TXD0 28 CTS0 43 RI0 
14 RXD0 29 DTR0 44 GND 
15 RTS0 30 DSR0 – – 
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DB44 (Female): RS-422 
Pin Signal Pin Signal Pin Signal 
1 RXD3+(B) 16 CTS3+(B) 31 TXD3-(A) 
2 TXD3+(B) 17 RXD3-(A) 32 CTS3-(A) 
3 RTS3+(B) 18 RTS3-(A) 33 GND3 
4 – 19 – 34 – 
5 RXD2+(B) 20 CTS2+(B) 35 TXD2-(A) 
6 TXD2+(B) 21 RXD2-(A) 36 CTS2-(A) 
7 RTS2+(B) 22 RTS2-(A) 37 GND2 
8 – 23 – 38 – 
9 RXD1+(B) 24 CTS1+(B) 39 TXD1-(A) 
10 TXD1+(B) 25 RXD1-(A) 40 CTS1-(A) 
11 RTS1+(B) 26 RTS1-(A) 41 GND1 
12 – 27 – 42 TXD0-(A) 
13 RXD0+(B) 28 CTS0+(B) 43 CTS0-(A) 
14 TXD0+(B) 29 RXD0-(A) 44 GND0 
15 RTS0+(B) 30 RTS0-(A) – – 

DB44 (Female): RS-485 (4-wire) 
Pin Signal Pin Signal Pin Signal 
1 RXD3+(B) 16 – 31 TXD3-(A) 
2 TXD3+(B) 17 RXD3-(A) 32 – 
3 – 18 – 33 GND3 
4 – 19 – 34 – 
5 RXD2+(B) 20 – 35 TXD2-(A) 
6 TXD2+(B) 21 RXD2-(A) 36 – 
7 – 22 – 37 GND2 
8 – 23 – 38 – 
9 RXD1+(B) 24 – 39 TXD1-(A) 
10 TXD1+(B) 25 RXD1-(A) 40 – 
11 – 26 – 41 GND1 
12 – 27 – 42 TXD0-(A) 
13 RXD0+(B) 28 – 43 – 
14 TXD0+(B) 29 RXD0-(A) 44 GND0 
15 – 30 – – – 

DB44 (Female): RS-485 (2-wire) 
Pin Signal Pin Signal Pin Signal 
1 Data3+(B) 16 – 31 – 
2 – 17 Data3-(A) 32 – 
3 – 18 – 33 GND3 
4 – 19 – 34 – 
5 Data2+(B) 20 – 35 – 
6 – 21 Data2-(A) 36 – 
7 – 22 – 37 GND2 
8 – 23 – 38 – 
9 Data1+(B) 24 – 39 – 
10 – 25 Data1-(A) 40 – 
11 – 26 – 41 GND1 
12 – 27 – 42 – 
13 Data0+(B) 28 – 43 – 
14 – 29 Data0-(A) 44 GND0 
15 – 30 – – – 
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CP-138U 
This board supports RS-422 and RS-485 (both 2 and 4-wire). 

Model Board Connector Supported Accessories Serial Connectors 

CP-138U DB62 (female) 

OPT8-M9 
CBL-M62M9x8-100 (OPT8D) 

8×DB9 (male) 

OPT8B 
CBL-M62M25x8-100 (OPT8C) 

8×DB25 (male) 

OPT8A, OPT8S, OPT8F, OPT8Z, OPT8K, 
OPT8I 

8×DB25 (female) 

DB62 (Female): RS-422, RS-485 (4-wire) 
Pin Signal Pin Signal Pin Signal 
1 RxD0+(B) 22 TxD0+(B) 43 – 
2 RxD0-(A) 23 – 44 – 
3 TxD1+(B) 24 TxD0-(A) 45 GND 
4 – 25 RxD1+(B) 46 – 
5 TxD1-(A) 26 RxD1-(A) 47 – 
6 RxD2+(B) 27 TxD2+(B) 48 – 
7 RxD2-(A) 28 – 49 – 
8 TxD3+(B) 29 TxD2-(A) 50 GND 
9 – 30 RxD3+(B) 51 – 
10 TxD3-(A) 31 RxD3-(A) 52 – 
11 TxD4+(B) 32 GND 53 – 
12 – 33 RxD4+(B) 54 – 
13 TxD4-(A) 34 RxD4-(A) 55 GND 
14 RxD5+(B) 35 TxD5+(B) 56 – 
15 RxD5-(A) 36 – 57 – 
16 TxD6+(B) 37 TxD5-(A) 58 GND 
17 – 38 RxD6+(B) 59 – 
18 TxD6-(A) 39 RxD6-(A) 60 – 
19 TxD7+(B) 40 GND 61 – 
20 – 41 RxD7+(B) 62 – 
21 TxD7-(A) 42 RxD7-(A) – – 
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DB62 (Female): RS-485 (2-wire) 
Pin Signal Pin Signal Pin Signal 
1 Data0+(B) 22 – 43 – 
2 Data0-(A) 23 – 44 – 
3 – 24 – 45 GND 
4 – 25 Data1+(B) 46 – 
5 – 26 Data1-(A) 47 – 
6 Data2+(B) 27 – 48 – 
7 Data2-(A) 28 – 49 – 
8 – 29 – 50 GND 
9 – 30 Data3+(B) 51 – 
10 – 31 Data3-(A) 52 – 
11 – 32 GND 53 – 
12 – 33 Data4+(B) 54 – 
13 – 34 Data4-(A) 55 GND 
14 Data5+(B) 35 – 56 – 
15 Data5-(A) 36 – 57 – 
16 – 37 – 58 GND 
17 – 38 Data6+(B) 59 – 
18 – 39 Data6-(A) 60 – 
19 – 40 GND 61 – 
20 – 41 Data7+(B) 62 – 
21 – 42 Data7-(A) – – 
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CP-138U-I 
This board supports RS-422 and RS-485 (both 2 and 4-wire). 

Model Board Connector Supported Accessories Serial Connectors 

CP-138U-I DB78 (female) 
CBL-M78M9x8-100 8×DB9 (male) 
CBL-M78M25x8-100 8×DB25 (male) 

DB78 (Female): RS-422, RS-485 (4-wire) 
Pin Signal Pin Signal Pin Signal 
1 GND7 27 RxD5-(A) 53 – 
2 RxD7+(B) 28 – 54 – 
3 – 29 RxD4-(A) 55 – 
4 GND6 30 – 56 – 
5 RxD6+(B) 31 – 57 – 
6 GND5 32 RxD3-(A) 58 – 
7 RxD5+(B) 33 – 59 – 
8 – 34 RxD2-(A) 60 TxD7-(A) 
9 GND4 35 – 61 TxD7+(B) 
10 RxD4+(B) 36 – 62 TxD6-(A) 
11 GND3 37 RxD1-(A) 63 TxD6+(B) 
12 RxD3+(B) 38 – 64 – 
13 – 39 RxD0-(A) 65 TxD5-(A) 
14 GND2 40 – 66 TxD5+(B) 
15 RxD2+(B) 41 – 67 TxD4-(A) 
16 GND1 42 – 68 TxD4+(B) 
17 RxD1+(B) 43 – 69 – 
18 – 44 – 70 TxD3-(A) 
19 GND0 45 – 71 TxD3+(B) 
20 RxD0+(B) 46 – 72 TxD2-(A) 
21 – 47 – 73 TxD2+(B) 
22 RxD7-(A) 48 – 74 – 
23 – 49 – 75 TxD1-(A) 
24 RxD6-(A) 50 – 76 TxD1+(B) 
25 – 51 – 77 TxD0-(A) 
26 – 52 – 78 TxD0+(B) 

DB78 (Female): RS-485 (2-wire) 
Pin Signal Pin Signal Pin Signal 
1 GND7 15 Data2+(B) 29 Data4-(A) 
2 Data7+(B) 16 GND1 30 – 
3 – 17 Data1+(B) 31 – 
4 GND6 18 – 32 Data3-(A) 
5 Data6+(B) 19 GND0 33 – 
6 GND5 20 Data0+(B) 34 Data2-(A) 
7 Data5+(B) 21 – 35 – 
8 – 22 Data7-(A) 36 – 
9 GND4 23 – 37 Data1-(A) 
10 Data4+(B) 24 Data6-(A) 38 – 
11 GND3 25 – 39 Data0-(A) 
12 Data3+(B) 26 – 40 – 
13 – 27 Data5-(A) 41 – 
14 GND2 28 – 42 – 
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CP-168U 
This board supports RS-232. With the OPT8F or OPT8Z accessory, it can support RS-422. With the OPT8K or 
OPT8I accessory, it can support RS-422 and RS-485 (both 2 and 4-wire). 

Model Board Connector Supported Accessories Serial Connectors 

CP-168U  DB62 (Female) 

OPT8-M9 
CBL-M62M9x8-100 (OPT8D) 

8×DB9 (Male) 

OPT8B 
CBL-M62M25x8-100 (OPT8C) 

8×DB25 (Male) 

OPT8A, OPT8S, OPT8F, OPT8Z, OPT8K, 
OPT8I 

8×DB25 (Female) 

OPT8-RJ45 8×RJ45 

DB62 (Female): RS-232 
Pin Signal Pin Signal Pin Signal 
1 TxD0 22 RxD0 43 CTS0 
2 DTR0 23 DSR0 44 RTS0 
3 RxD1 24 DCD0 45 GND 
4 DSR1 25 TxD1 46 CTS1 
5 DCD1 26 DTR1 47 RTS1 
6 TxD2 27 RxD2 48 CTS2 
7 DTR2 28 DSR2 49 RTS2 
8 RxD3 29 DCD2 50 GND 
9 DSR3 30 TxD3 51 CTS3 
10 DCD3 31 DTR3 52 RTS3 
11 RxD4 32 GND 53 CTS4 
12 DSR4 33 TxD4 54 RTS4 
13 DCD4 34 DTR4 55 GND 
14 TxD5 35 RxD5 56 CTS5 
15 DTR5 36 DSR5 57 RTS5 
16 RxD6 37 DCD5 58 GND 
17 DSR6 38 TxD6 59 CTS6 
18 DCD6 39 DTR6 60 RTS6 
19 RxD7 40 GND 61 CTS7 
20 DSR7 41 TxD7 62 RTS7 
21 DCD7 42 DTR7 – – 
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POS-104UL 
This board supports RS-232 only. 

Model Board Connector Supported Accessories Serial Connectors 
POS-104UL DB44 (female) CBL-M44M9x4-50(POS) 4×DB9 (male) 

DB44 (Female): RS-232 
Pin Signal Pin Signal Pin Signal 
1 TxD3 16 CTS3 31 DCD3 
2 RxD3 17 DTR3 32 – 
3 RTS3 18 DSR3 33 GND 
4 5V/12V/RI3 19 – 34 – 
5 TxD2 20 CTS2 35 DCD2 
6 RxD2 21 DTR2 36 – 
7 RTS2 22 DSR2 37 GND 
8 5V/12V/RI2 23 – 38 – 
9 TxD1 24 CTS1 39 DCD1 
10 RxD1 25 DTR1 40 – 
11 RTS1 26 DSR1 41 GND 
12 5V/12V/RI1 27 – 42 DCD0 
13 TxD0 28 CTS0 43 5V/12V/RI0 
14 RxD0 29 DTR0 44 GND 
15 RTS0 30 DSR0 – – 
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Serial Connectors 

DB9 (Male) 

The following accessories provide DB9 (male) serial connectors for your UPCI board: 

Accessory Board Connector Serial Connectors 
CBL-M25M9x2-50 DB25 (female) 2×DB9 (male) 
CBL-M44M9x4-50 DB44 (female) 4×DB9 (male) 
CBL-M44M9x4-50(POS) DB44 (female) 4×DB9 (male) 
CBL-RJ45M9-150 RJ45 4×DB9 (male) 
OPT8-M9 
CBL-M62M9x8-100 (OPT8D) 

DB62 (female) 8×DB9 (male) 

CBL-M78M9x8-100 DB78 (female) 8×DB9 (male) 

 

The pin assignments for the DB9 (male) serial connector are shown below. There are different pin 
assignments depending on the serial interface that your board is configured for. 

Pin RS-232 RS-422/RS-485 (4W) RS-485 (2W) 
1 DCD TxD-(A) – 
2 RxD TxD+(B) – 
3 TxD RxD+(B) Data+(B) 
4 DTR RxD-(A) Data-(A) 
5 GND GND GND 
6 DSR – – 
7 RTS – – 
8 CTS – – 
9 *5V/12V/RI – – 

* The 5V/12V/RI signal only applies to the POS-104UL 
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DB25 (Male) 

The following accessories provide DB25 (male) serial connectors for your UPCI board: 

Accessory Board Connector Serial Connectors 
CBL-M44M25x4-50 DB44 (female) 4×DB25 (male) 
CBL-RJ45M25-150 RJ45 4×DB25 (male) 
OPT8B 
CBL-M62M25x8-100 (OPT8C) 

DB62 (female) 8×DB25 (male) 

CBL-M78M25x8-100 DB78 (female) 8×DB25 (male) 

 

The pin assignments for the DB25 (male) serial connector are shown below. There are different pin 
assignments depending on the serial interface that your board is configured for. 

Pin RS-232 RS-422/RS-485 (4W) RS-485 (2W) 
2 TxD RxD+(B) Data+(B) 
3 RxD TxD+(B) – 
4 RTS – – 
5 CTS – – 
6 DSR – – 
7 GND GND GND 
8 DCD TxD-(A) – 
20 DTR RxD-(A) Data-(A) 
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DB25 (Female) 

The following accessories provide DB25 (female) serial connectors for your UPCI board: 

Accessory Board Connector Serial Connectors 
OPT8A, OPT8S, *OPT8F, *OPT8Z, *OPT8K, 
*OPT8I 

DB62 (female) 8×DB25 (female) 

* The OPT8F, OPT8Z, OPT8K, and OPT8I are designed for use with the CP-168U only. 

 

The pin assignments for the DB25 (female) serial connector are shown below. There are different pin 
assignments depending on the serial interface that your board is configured for. 

OPT8A, OPT8S 
Pin RS-232 RS-422/RS-485 (4W) RS-485 (2W) 
2 RxD TxD+(B) – 
3 TxD RxD+(B) Data+(B) 
4 CTS – – 
5 RTS – – 
6 DTR RxD-(A) Data-(A) 
7 GND GND GND 
8 DCD TxD-(A) – 
20 DSR – – 

OPT8F, OPT8Z, OPT8K, OPT8I 
Pin RS-422/RS-485 (4W) RS-485 (2W) 
2 RxD+(B) Data+(B) 
3 TxD+(B) --- 
7 GND GND 
14 RxD-(A) Data-(A) 
16 TxD-(A) --- 
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RJ45 

The following accessories provide RJ45 serial connectors for your UPCI board: 

Accessory Board Connector Serial Connectors 
OPT8-RJ45 DB62 (female) 8×RJ45 

 

The pin assignments for the RJ45 serial connector are shown below. Only RS-232 is supported. The OPT8-
RJ45 accessory should only be used with the CP-118U in RS-232 mode or with the CP-168U. 

Pin RS-232 
1 DSR 
2 RTS 
3 GND 
4 TxD 
5 RxD 
6 DCD 
7 CTS 
8 DTR 
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